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Chapter 1: Introduction 
Welcome to the Test Automation on Windows Phone Getting Started guide. This document will assist 

you with installing, configuring and using M-eux Test. To make sure you can get started automating your 

test cases as soon as possible, we invite you to closely follow the instructions contained in this guide.  

We have made every attempt possible in making the instructions in this guide as clear as possible. 

However, we recognize that we are unable to cover everything in a single guide. Should you require 

further assistance, please do not hesitate to visit our www.jamosolutions.com website or to contact our 

support team at support@jamosolutions.com. 

After reading his document, you should be familiar with the following topics: 

 Test automation on real Windows Phone devices 

 Test automation on Windows Phone emulators 

 Best practices on Windows Phone testing 

1.1. M-eux Test overview 

To test mobile applications using M-eux Test, you need three main components. The Windows Phone 

device or Windows Phone emulator hosts the application that you want to test. You use a scripting 

environment in which you write and execute your scripts. Finally, the M-eux Test Device Manager is the 

core of our application and acts as the gateway between the mobile devices and scripting environment. 

M-eux Test currently supports the following products: 

 Windows Phone Devices: Windows Phone 7.5 and Windows Phone 8 are supported. 

 

Figure 1: M-eux Test Architecture 

1.2. How to use this document 

This document will get you started with using M-eux Test for testing applications on Windows Phone. To 

get started, here’s what you need to do: 

http://www.jamosolutions.com/
mailto:support@jamosolutions.com
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- Get your PC ready. You will first need to install M-eux Test on your PC. 

- Get your device or emulator ready. Depending on your testing strategy, you may want to run 

your test on a physical device or an emulator. M-eux Test supports both.  

- Create your first script. Once your pc, device and app are ready, you can start creating your first 

script.  

1.3. Where to go from here 

This document will get you started creating your first script. If you want to further explore the features 

of M-eux Test, please visit our website at www.jamosolutions.com for further information on the 

features of M-eux test.  

http://www.jamosolutions.com/
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Chapter 2: Get your PC ready 

2.1. System Requirements 

The supported systems and requirements: 

Computer/processor IBM-PC or compatible with a Pentium III or higher (Pentium IV or 
higher recommended) microprocessor. 

Operating System Windows Desktop 

 Windows XP 32-Bit Edition—Service Pack 3, 

 Windows Vista (32-bit edition & 64-bit Edition), 

 Windows 7 (32-bit Edition & 64-bit Edition) 

 Windows 8 (32-bit edition & 64-bit edition) 

 Windows 8.1 (32-bit edition & 64-bit edition) 
 
Windows Server 

 Windows Server 2003 32-bit Edition—Service Pack 1, 

 Windows Server 2003 R2 (32-bit x86), 

 Windows Server 2008 (32-bit & 64-bit edition) 

 Windows Server 2008 R2  

 Windows Server 2012  

 Windows Server 2012 R2 

Memory Minimum of 2 GB. 

Color Settings Minimum of High Color (16 bit). 

Free disk space 1 GB of free disk space for application files and folders and an 
additional 1 GB of free disk space on the system disk (the disk on 
which the operating system is installed). 
The free disk space requirements do not include disk space required 
for any prerequisites that may need to be installed before installing 
M-eux Test. 
After M-eux Test is installed, it is recommended to have at least 1 GB 
free disk space on the system disk for the operating system and M-
eux Test to run correctly. 

2.2. Prerequisites  

To install M-eux Test on your computer, you first need to install the following prerequisites: 

- Optionally, OCR components 

Once all prerequisites have been installed, you can continue with the installation of M-eux Test. You 

may be required to execute some post-configuration tasks to ensure M-eux Test will work correctly in 

your environment. 
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2.2.1. Mobile Device Prerequisites 

In case of Windows Mobile devices and emulators, ActiveSync from Microsoft is needed in order to 

connect the PC to the mobile device for Windows XP and Windows 2003. Windows Vista and Windows 7 

require the Windows Mobile Device Center. 

In case of Android devices, the SDK of Android needs to be installed together with the USB drivers from 

Android in order to connect the mobile device with the PC using a USB cable. 

In case of BlackBerry devices, the “BlackBerry Desktop Software” needs to be installed. 

For iOS devices – you can download the latest iTunes from apple website. 

2.2.2. Required Privileges 

You need to have local system administration rights in order to install the product. 

2.2.3. Visual C++ 2010 Redistributable 

M-eux Test requires the Visual C++ 2010 Redistributable to be installed on your PC. You can download 

the Visual C++ 2010 Redistributable from http://www.microsoft.com/en-

us/download/details.aspx?id=8328 . 

2.2.4. .NET Framework 4.0 

M-eux Test requires version 4.0 of the .NET Framework to be installed on your PC. You can download 

the .NET Framework from http://www.microsoft.com/en-us/download/details.aspx?id=17718 . 

2.3. Installing M-eux Test  

In order to test applications on Android devices or Android emulators, you need to install the M-eux 

Device manager. As shown in the architecture, the device manager is used to communicate between the 

device and the test tools. 

You can download the set up on our website:  M-eux Test Setup at 

http://www.jamosolutions.com/memberArea/downloads.php. You will need to have a credential to log 

in the member area network. If you do not have the credentials yet, please email us at 

info@jamosolutions.com 

It is mandatory to install the application with admin rights, simply right click on the MeuxSetup.msi and 

run as admin rights. 

2.3.1. Preparation 

1. First step is to execute the MeuxSetup.msi file from the M-eux build you downloaded on your PC. 

The dialog boxes will guide you through the installation. 

2. Click Next 

http://www.microsoft.com/en-us/download/details.aspx?id=8328
http://www.microsoft.com/en-us/download/details.aspx?id=8328
http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.jamosolutions.com/memberArea/downloads.php
mailto:info@jamosolutions.com
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Figure 2 Installing M-eux Test 

3. Setup will check the components which are already installed on the pc and will indicate if any 

additional component is required. Review all warnings and errors and click Next to continue the 

installation process. 

 

Note: The Android SDK check will issue a warning if you have downloaded and copied the zipped 

version of the SDK. No warning will be displayed if you have used the installer to install the Android 

SDK. Please see the instructions here for more information. 

 

4. If you agree with the License Agreement, select I accept the terms in the License Agreement and 

click Next. 
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Figure 3 Accepting license 

5. Select: 
a.  Unified Functional Testing (QuickTest Professional) if you want to use M-eux Test with 

QTP/UFT.  
b. Select Visual Studio 2005 if you want to use M-eux Test with Visual Studio 2005 sp1.  
c. Select Visual Studio 2008 if you want to use M-eux Test with Visual Studio 2008 sp1.  
d. Select Visual Studio 2010 if you want to use M-eux Test with Visual Studio 2010.  
e. Select Visual Studio 2012 if you want to use M-eux Test with Visual Studio 2012.  
f. Select Visual Studio 2013 if you want to use M-eux Test with Visual Studio 2013.  
g. Select Execution M-eux Visual Studio scripts if you want to execute only Visual Studio based 

scripts on this PC.  
h. Select Eclipse Extension if you want to use M-eux Test with Eclipse 

Note: You cannot extend Visual studio 2008 and Visual studio 2005 at the same time. 

 

Figure 4 Choose Extensions 

6. If you have selected the Eclipse Extension then setup will ask you to point to the directory where 

Eclipse is installed. Please make sure you point to a 32-bit version of Eclipse. 
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7. Click on “Install” to start the actual installation. 

 
8. Wait until Setup is has completed. Depending on your environment, this may take up to 10 minutes 

as setup is preparing your PC for smooth automation. 
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2.4. License activation 

Start the device manager application on the PC. 

When starting the first time the device manager, you get the device manager without possibility to 

connect devices or tools. You have to install a license first. Depending on the purchased license(s), you 

can choose between seat, site and token license. 

Seat License activation 

In case of a seat license, select the menu Tools, License, New license, Seat. Write down the locking id 

and send this id to Jamo Solutions: support@jamosolutions.com. Jamo solutions will return the file with 

the license keys. A path name to this file needs to be entered in the edit field linked to the Seat License 

Details section. You can write the path manually or use the ‘Select button’ to find and select your license 

key file. 

 

Figure 5 Seat license activation 

After selecting “OK”, the file will be read and the seat license will be installed. 

mailto:support@jamosolutions.com
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Site license activation 

In case of a site license, select the menu Tools, License, New license, Site. Enter the IP or hostname and 

port of the license server.  The license server URL will be generated automatically. 

 

Figure 6 Site license activation 

Note that prior to connecting to the license server machine, the license server needs to be installed on 

that machine.  The licenses will be checked at run-time, so you need to be connected to the license 

server all the time while using the Device Manager. 

If you have problems connecting to the license server, then please contact your product administrator 

who is responsible for the M-eux license server. 

Note the site license will be released if you shut down your device manager. So if you want to transfer 

the site license to another tester in your company. You just need to shut down your Meux Device 

Manager. 

Token license activation 

Token licenses are distributed by your local license server. They allow you to use the tool while not 

being connected to the license server. 

In case of a token license, select the menu Tools, License, New license, Token. In the details enter the IP 

or hostname and port of the license server.  The license server URL will be generated automatically. 
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Figure 7 Token license activation 

Note that prior to connecting to the license server machine, the license server needs to be installed 

activated and running on that machine.  

 The checkbox Web Add-in consumes a web support for each tool demanded license. 

 The Token # days edit field contains the number of days that the token will be used by the 

machine, i.e. the number of days that the token will be valid. 

 The checkbox DM Professional denotes the license for the device manager professional edition. 

A license device manager professional activates the WAN Connector and local scheduler 

functionality. 

 The checkboxes Specific Platform and Platform All denote the platform of your connected 

devices. Only one of these checkboxes can be checked.  

 If you check Specific platform you have to select in the combo box under the platform you wish. 

If you select nothing, the Windows Mobile/CE platform will be levied. Selecting Windows 

Mobile/CE denotes that Mobile-based or Windows CE-based devices can connect to the Device 

Manager directly or indirectly through the WAN connector. Selecting Android denotes that 

android-based devices can connect to the Device Manager directly or indirectly through the 

WAN connector. 

 Checkbox Platform All denotes that any supported mobile device can connect to the Device 

Manager directly or indirectly through the WAN connector. 

 The other fields contain the number of token-licenses you want to have active for the specified 

time period indicating that all tokens have the same duration as specified in Token #days. 

Following table explains the tokens one can request: 
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Token Edit field Description 

Development Denotes the number of development tokens. With one development 
token, the QA engineer can create, modify and execute a script. Normally 
this number is one since most of the time the QA engineer is working on 
one script at a time. 

Execution Denotes the number of execution tokens. With one execution token, you 
can execute a script. With N execution tokens, you can execute N scripts 
simultaneously. 

Tool QTP (QuickTest 
Professional) 

Denotes the number of QuickTest Professional tokens. This number is 0 or 
one since you can run only one QuickTest Professional instance at a time. 

Tool ALL Denotes the number of tool instances you can launch simultaneously. 
Currently QuickTest Professional and QuickTest Professional are supported. 

 

After clicking OK, you will receive an overview of requested and received licenses. If all requested 

licenses are not granted, it means that they are in use by other users. 

 

Figure 8 Token license overview 

Note that for any license installation (install new license, switch to another license or release token 

license) all devices and tools have to be disconnected. 

Handling the token license 

All token licenses have an expiration date. If you want to release these tokens before the expiration 

date, you can do it by calling the menu item Tools, License, Release Token License or by installing a new 

license (seat, site).  Before calling one of these menu items, you need to connect your machine to the 

network so that the license server is reachable. The menu item Release Token License will release all 

tokens and switch your license to site license connecting to the same license server address that was 

used to book and un-book the tokens. 
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Managing the professional license 

The Device Manager will at startup time look to book a Professional license. You can release this license 

and use the Device Manager in Standard mode by selecting Tools, Licenses, Release Device Manager 

Pro. Performing this action will disconnect all connected WAN connectors and disable the scheduler. 

If the Device Manager is in Standard mode, you can book a Professional license by selecting the menu 

Tools, Licenses, Get Device Manager Pro. 

You can verify the mode the Device Manager is in by inspecting the menu entry in Tools, Licenses. The 

menu entry Release Device Manager Pro indicates that the Device Manager is in Professional mode. The 

menu entry Get Device Manager Pro indicates that the Device Manager is in Standard mode.  

License overview 

 

Figure 9 License overview 

At each time you can check your available licenses in menu Tools, Licenses, License Overview. The 

displayed form shows the number of licenses in use and if using a seat or token license, the number of 

licenses available locally on your PC. 

2.5. Troubleshooting 

2.5.1. The device is not able to (re)connect to the M-eux device manager  

The communication between the PC and the mobile device is using the TCP/IP network protocol. A local 

firewall installed on the PC may block the communication between the PC and the mobile device. The 

TCP/IP protocol uses ports and IP addresses to establish communications. 
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We recommend you allow communication on the following IP-address blocks: 

- 169.254.*.* (autoconfiguration IP addresses) 

- 192.168.*.* (private IP range) 

- All other IP ranges that are used for establishing connections between the mobile device and 

the desktop (e.g. Wi-Fi, Bluetooth, …) 

And on the following ports: 

- 4444, 555, 5580-5590 

2.5.2. The device manager ports are already in use 

Since the communication between the Device Manager and the script (and vice versa) is using .Net 

Remoting technology, ports are needed for communication. The ports that are used by the M-eux Test 

tool can be modified in “MeuxDeviceManager.exe.config” (see the bin folder of the installation 

directory). 

After launching Device Manager or Wan Connector you get message(s) that a port is already used on 

this machine 

 

You have to go to the configuration file of Device Manager (Wan Connector) and change the specified 

port there. For details see the User guide, section Wan Connector configuration. 

 

1. Make sure your local firewall does not block the communication of the device manager, you can 

enable the communication by: Control panel—Firewall—Allowed programs and make sure you 

have device manager listed in there and it can communicate through firewall in both home and 

public network. 
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Figure 10 allow the communication of Device Manager on firewall 

 

If the Device Manager program does not appear in the above window, you can click the button Allow 

another program in the above picture and point to MeuxDeviceManager.exe in the bin directory of the 

M-eux Test. 
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Chapter 3: Getting your device ready 
You can connect Windows Phone device using WiFi or with USB cable (recommended). 
Please note that for Windows Phone 8, connection to the Device Manager is available only over Wi-Fi. 
USB connection to the device manager is not supported as yet for Windows Phone 8. 

3.1. Connect using WiFi 

If you want to connect your device to the device manager using WiFi, please make sure both your PC 

and your device are connected to the same WiFi network. 

3.2. Connect the device using USB 

This mode of connection to the device manager is not currently available for Windows Phone 8. 

You will need the software called Zune (http://www.windowsphone.com/en-us/how-to/wp7/zune-

software) in order to establish the connection using USB, Zune will forward the communication from the 

device to the device manager. You can simply follow the below steps: 

1. Install Zune software on your PC. 

3. You can disable the wifi connection on your device 

4. Connect your device with your PC using USB cable, the Zune software should launch up 

automatically, if not, please launch Zune manually on your PC 

 

http://www.windowsphone.com/en-us/how-to/wp7/zune-software
http://www.windowsphone.com/en-us/how-to/wp7/zune-software
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Chapter 4: Getting your application ready 

4.1. Known limitations: 

 Only native applications are supported. The web applications are not supported yet. 

 Recording is not implemented for Metro based applications (WP 8). 

4.2. Connection to Device manager 

 
In contrast to the other mobile OS the M-eux Agent does not exist in our Win Phone solution.  
There is currently one method to connect to the device manager over Wi-Fi.  

 Using Contact method – This method can be used in the scenarios where the IP address of the 
test machine changes frequently.  

 

4.3. Using Contact Method 

4.3.1. Recompile your application 

To be able to test on Windows Phone you have to link and initialize our Client library in your application. 

This is made in following way: 

1) Include a reference to the ClientAgent.dll  to your project: 
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2) In the App.xaml.cs file make following changes: 

a. In the main application class declare a new variable: 

ClientAgent.ClientAgent ca = null; 
 

b. At the end of the constructor initialize the client: 
ca = ClientAgent.ClientAgent.getInstance (); 

 

c. In the activation procedure of the application call the start function of the agent: 

       private void Application_Activated(object sender, ActivatedEventArgs e) 
       { 
           ca.StartAgent (); 
       } 

 

d. In the closing function of the application call the stop function of the agent: 
       private void Application_Closing(object sender, ClosingEventArgs e) 
       { 
           ca.StopAgent (); 
       } 

 

You can review the changes in the TestApplication included in the setup of the tool. 

4.3.2. Create the contact 

The settings for the connection will be picked up from a contact in the contact list of your application; 
the port 4444 is used as standard in this moment.  
 
Please install the application that contains our library. This is a onetime process. If the IP address of your 
machine keeps changing, you can edit the contact filed to update it with your new IP address. Appendix 
A describes how the application needs to be adapted in order to be able to create your automatic test 
scripts with M-eux Test. 
 
You can install the test application rebuilt with our library. The test application is in the setup directory 
for Windows phone (for example: Jamo Solutions\M-eux Test\setup\Windows Phone\Windows Phone 
7.5) 
 
When you launch the application under test for the first time, you will get the Contact application 
popped up with the connection details by default: 
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You have to edit the details (device name and IP to connect) to the desired values: 
 
 

 
 
 
On the contact, please fill in the following information: 
 
First name: your device name 
Last name: The IP address of your PC 
Title: JamoSettings 
 
Then you need to save the contact and restart the application under test. Once the contact created, you 
have only to edit it before you launch the application under test. The values will be picked up only at the 
start of the application. If your application goes to the background and you wish to change the IP to 
connect, you need to reset the application under test. 
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Start the application under test. We will use the Test Application to create the first script. 

 

The device will be connected to Device manager 
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Chapter 5: Your first script 
M-eux Test extends three well known environments to create your scripts: Quick Test Professional from 

Hewlett Packard and Quick Test Professional from Microsoft and Eclipse. Detailed information on both 

environments can be found in the guide: ‘User’s Guide – QTP’ or ‘User’s Guide Quick Test Professional’ 

or ‘User’s Guide - Eclipse ’.  

The following section explains the creation of the first script in QuickTest Professional. The section after 

that explains creation of the script in Visual Studio, and Eclipse is explained last.  

Before starting to script please make note of the following: 
1. The ConfigParamSet() and the ConfigParamGet() functions are not available. 
2. The ChildObjects() function will only return the direct children of the corresponding object with 

the defined properties. It will not return the entire object hierarchy.  
For more information on the properties and the functions available please refer the 'Function 
Reference'(Device Manager-> Help-> Function Reference) 

5.1. QuickTest Professional 

Scripts can be created by learning the actual window on the device and by manual completion of the 

test commands in QuickTest Professional, or by recording the actions.  

Example: Create a script on the delivered TestApplication  

Following sample is created using Windows Phone 7.5, the test application and QuickTest Professional 

11.  

Press the recording button in QuickTest Professional.     

In the Recording settings window, make sure that you do not record and run on any open Windows 

Application. Instead make sure that no recording will be done in a windows application as illustrated on 

following image: 
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Click OK to close the settings window. 

Switch to your Windows Phone.Click on Toggles,click on RadioButton,select the checkbox then click on 

back.Stop recording. Following actions were recorded: 

 

Now you can replay the script. 

5.2. Microsoft Visual Studio 

Following sample script is created using Visual Studio 2008, the test application and Windows Phone 

Create a new project and select the template: M-eux Test script. 

 

Click OK on the M-eux Test script dialog box.  
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Click ‘Yes’ in the Visual Studio dialog box. This dialog box only appears in Visual Studio 2005. No dialog 

box will be displayed in Visual Studio 2008. 

 

In Visual Studio open the “Add-in manager” dialog box from the “Tools Menu”. 

 

Select the “M-eux VS Addin” option 
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“M-eux Test” menu will be added in Visual Studio 

 

 

 

Select “Connect” from the “M-eux Test Menu” to connect Visual Studio to the device manager. The 

“Visual Studio Addin” will be listed in “Connected Testing Tools”. 

 

 

Select “Start Recording” from the “M-eux Test Menu”. 

 

Put the cursor after “Have fun” in the RunCore method. That is where statements will be recorded. 
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Switch to Windows Phone 

Click on Toggles,click on RadioButton,select the checkbox then click on back 

Stop recording. 

Following actions were recorded: 
 

 
 

Replay the script. 

5.3. Eclipse 

This section explains how to create your first script in Eclipse.  

1. In Eclipse click “File” -> “New” -> “Other…” 
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2. In the following window select “Jamo Solutions” -> “M-eux Test” 
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3. Specify project name and desired location 
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4. Press “Connect” button on the toolbar to connect Eclipse to Device Manager. The “Eclipse 

Addin” will be listed in “Connected Testing Tools” in Device Manager. 

 

 
 

 

 

 

5. Press “Start Recording” button on the toolbar. 

 

 

 

Following steps will be recorded in the body of the runCore function of UserScript.java in Eclipse 

until the recording is stopped.  Statements will always be added at the end of the script. 

 

 

6. Switch to Windows Phone 

Click on Toggles,click on RadioButton,select the checkbox then click on back 

 

 

7. Press “Stop Recording” button on the toolbar 
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Following image shows the recorded script: 

 

 
 

8. Press ‘Run’ on the toolbar to run the script. 
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Chapter 6: Summary 
Now you should be able to start with the testing on Windows Phone.  

We wish you a good journey with your test adventure using M-eux Test tool. If you are facing any issues 

with our tool, or having trouble about making your test scripts for your test cases, you can always 

contact us at support@jamosolutions.com.  

mailto:support@jamosolutions.com

